How to Navigate the **SAP Concur Support Portal**
A Guide for Authorized Support Contacts

October 2020
TABLE OF CONTENTS

1 CONTACT SUPPORT LINK LOCATIONS AND ACCESS .......................................................... 4
1.1 Where to locate the Contact Support link? ........................................................................ 4
1.2 How to activate access to the portal? ............................................................................... 4

2 SAP CONCUR SUPPORT PORTAL – HOME PAGE AT A GLANCE ...................................... 5

3 MY PROFILE OPTIONS AND PREFERENCES ................................................................. 6
3.1 How do I create my profile? ............................................................................................. 6
3.2 How do I update my profile? ........................................................................................... 6
3.3 How do I change my language preference? ..................................................................... 6

4 GLOBAL SEARCH – ASK ME ANYTHING ............................................................................. 6
4.1 What can I search for when using the Ask me anything search bar? ............................. 6

5 INFORMATION CENTER ...................................................................................................... 7
5.1 What is the purpose of the Information Center? ............................................................... 7
5.2 How do I receive an Information Center Notice via e-mail? .......................................... 7
5.3 How do I view all Information Center Notices? .............................................................. 7

6 REQUEST SUPPORT .......................................................................................................... 7
6.1 What is the best practice before I request assistance? .................................................... 7
6.2 How do I request assistance? ......................................................................................... 8
6.3 What information do I need to provide? .......................................................................... 8
6.4 How do I begin a Chat session? ..................................................................................... 8
6.5 Where can I find the global SAP Concur Support phone numbers? .............................. 9

7 KNOWLEDGE BASE ............................................................................................................ 9
7.1 How do I search for Knowledge Base articles? ............................................................... 9
7.2 In what supported languages may Knowledge Base articles be offered? .................... 11
7.3 How do I view a Knowledge Base article in another supported language? .................. 11

8 CASE MANAGEMENT ......................................................................................................... 11
8.1 How do I create a case? .................................................................................................. 11
8.2 How does SAP Concur Support determine the order to work cases? ............................. 14
8.3 How do I view a case? .................................................................................................. 14
8.4 How do I close a case? ................................................................................................. 15
8.5 How do I print cases? ................................................................................................... 16
8.6 How do I download a case report? ................................................................................ 16

9 RESOURCES ....................................................................................................................... 17
9.1 How do I find general information such as technical documentation and training options? 17
9.3 What is a Fact Sheet? .................................................................................................... 17
9.4 How do I print Fact Sheets? .......................................................................................... 18
9.5 How do I find training information? .............................................................................. 18

10 COMMUNITY INFO .......................................................................................................... 18
10.1 Community .................................................................................................................. 18
10.1.1 How do I post a question?........................................................................................................... 19
10.1.2 How do I search for items posted?.............................................................................................. 19
10.1.3 How do I comment on a post made by another user? ............................................................... 20
10.1.4 How do I view a list of questions I submitted on the portal? .................................................. 20
10.2 Solution Suggestions..................................................................................................................... 21
10.2.1 Where do I change my Solution Suggestions Nickname?.......................................................... 21
10.2.2 What do the different statuses for Solution Suggestions mean?............................................. 21
10.2.3 How do I view Solution Suggestions?........................................................................................ 21
10.2.4 How do I search for an existing Solution Suggestion?............................................................. 22
10.2.5 How do I promote a Solution Suggestion?................................................................................. 22
10.2.6 How do I submit a Solution Suggestion?.................................................................................... 23
10.2.7 How do I view my suggestions or votes?.................................................................................... 23
11 BILLING............................................................................................................................................. 24
11.1 How do I access invoices online?.................................................................................................. 24
12 CUSTOMER SUPPORT DOCUMENTATION AND E-LEARNING.............................................. 24
1 CONTACT SUPPORT LINK LOCATIONS AND ACCESS

1.1 Where to locate the Contact Support link?
Once the Authorized Support Contact (ASC) permission has been assigned, the Contact Support link will automatically appear within SAP Concur for convenient access to the SAP Concur Support Portal via Single Sign-On (SSO). The Contact Support link usually appears under Help, but may also appear at the bottom of the page or as Support next to the Help tab.

1.2 How to activate access to the portal?
To allow access, ensure pop-up blocker is disabled and add one of the following as a trusted site in your browser settings:


To activate access, click Help > Contact Support (refer to 1.1).
1. **My Profile | Close (Log out):** Easily update profile information and log out (Close).
2. **Menu Tabs:** Access to the most commonly used features.
3. **Ask me anything Search Bar:** Quick access to Knowledge Base answers, cases, Solution Suggestions, Training, Technical Publications (e.g. User Guides), and SAP Community.
4. **Information Center:** View important notices from Support, Security, and Operations (maintenance) and opt-in to receive these notices by e-mail.
5. **Create and View Cases:** A designated area for prompt and convenient access to cases.
6. **Knowledge Base:** Accessible from different SAP Concur Support Portal pages to easily find answers.
7. **Suggestions:** Submit, view, and vote on Solution Suggestions.
8. **Chat with Support:** Receive assistance through chat for quick questions.
9. **Call Support:** Link to access the Global Support phone numbers.
10. **From the Community:** A place for customers to share information with each other.
11. **Quick Link Menu Bar:** Complete visibility of the top Menu Tabs and drop-down menu selections.
3 MY PROFILE OPTIONS AND PREFERENCES

3.1 How do I create my profile?
When transferring to the portal for the first time, the User Information Confirmation box will display prompting to create your profile. Follow the steps below:
1. Review first name, last name, and e-mail address. If your name or e-mail needs modification, please contact your Concur Administrator as changes must be made in your SAP Concur profile.
2. Complete the required fields.
3. Select your preferred language from the drop-down list. The default is English.
4. Choose your preferences:
   - Service Alerts - Receive e-mails from concursupport-servicealerts@concur.com for any incidents managed outside of Concur Open, our System Status Dashboard, or extenuating notifications other than incident management.
   - Language Support - Accept support in English when high demand for specific language support causes a delay in cases being addressed.
   - Information Center Notices - Receive important Information Center Notice e-mails from Support, Security, and Operations.
   - Case Calls - Opt out to receive calls regarding cases.
5. Update any optional fields.
6. Click Save.

3.2 How do I update my profile?
To make updates to your profile, click My Profile in the upper right corner of the home page.

3.3 How do I change my language preference?
In addition to English, there are seven localization options for ASCs: Chinese (Simplified), French, German, Japanese, Korean, Portuguese (Brazilian), and Spanish. To change your language preference, navigate to My Profile and choose an option from the Select Your Language drop-down menu and click Save.

When a different language is chosen, this affects the static pages; headers, footers, content in the drop-down for case topic, and case type values are translated accordingly.

Note: For customers who have purchased the User Support Desk (USD) service, end-users can choose between six localization options in addition to English upon initial login to the USD Portal: Chinese (Simplified), French, German, Japanese, Portuguese (Brazilian), and Spanish. Language options can be changed at any time within the end-user’s USD Portal profile.

4 GLOBAL SEARCH – ASK ME ANYTHING

4.1 What can I search for when using the Ask me anything search bar?
The Ask me anything search bar makes searching an easy task. Type in a subject and a list of related topics will display results by category: Article, Cases, Solution Suggestion, Community Posts, training materials, or search for a specific case number or Solution Suggestion ID.
5 INFORMATION CENTER

5.1 What is the purpose of the Information Center?
The Information Center provides pertinent information regarding communications from Support, Security, and Operations (maintenance). The information provided here does not pertain to P1 incidents. To learn more about how to view and track P1 incidents, please refer to the Getting the Most from SAP Concur Support document located in the Concur Training Library.

5.2 How do I receive an Information Center Notice via e-mail?
ASCs may opt in to receive Information Center Notices via e-mail by following these steps:
1. Click My Profile.
2. Scroll down to Preferences and select Opt In to receive Information Center Notices.
3. Click Save.
Note: The Information Center Notice e-mails are sent from the Concur Support Information Center (informationcenter-no-reply@concur.com).

5.3 How do I view all Information Center Notices?
Click See All Information Center Notices in the Information Center located on the Home page.

6 REQUEST SUPPORT

6.1 What is the best practice before I request assistance?
Prior to contacting SAP Concur Support for assistance, ASCs are encouraged to check the following:
- Knowledge Base for possible solutions.
• Information Center for posted notices or your inbox if opted in to receive notices via e-mail.
• **Concur Open** or your inbox if you have subscribed to Personalized Concur Open Updates.
• If the issue occurred during the Saturday standard maintenance window.

<table>
<thead>
<tr>
<th>Region</th>
<th>Time (UTC)</th>
<th>Time (PST/PDT)</th>
</tr>
</thead>
<tbody>
<tr>
<td>North America</td>
<td>12 AM to 4 AM UTC</td>
<td>5 PM to 9 PM PST/PDT</td>
</tr>
<tr>
<td>EMEA</td>
<td>9 PM to 1 AM UTC</td>
<td>11 PM to 3 AM CET/CEST</td>
</tr>
<tr>
<td>China</td>
<td>3 PM to 7 PM UTC</td>
<td>11 PM to 3 AM SGT</td>
</tr>
</tbody>
</table>

**Note:** For more information on **Concur Open**, Personalized Concur Open, and standard maintenance window, refer to the *Getting the Most from SAP Concur Support* document located in the **Concur Training Library**.

### 6.2 How do I request assistance?

Authorized Support Contacts can contact SAP Concur Support for assistance by creating a case in the SAP Concur Support Portal, chat, or phone. To report an issue, ask a question, or make a request, the preferred method is to create a case. Regardless of the complexity of the issue or request, submitting a case provides the most efficient results by allowing detailed information and relevant documents to be included.

Chat and phone support are most effective for basic questions that can be quickly answered. ASCs will be asked to provide their name, company name, SAP Concur solution, and to verify the e-mail address associated with the account. The SAP Concur Support representative will create a case to provide a transcript of the conversation for our records. Should more advanced support be required, the case will be transferred to the group with the appropriate level of expertise.

### 6.3 What information do I need to provide?

For SAP Concur Support to resolve an issue, the steps to reproduce must be provided. When possible, copy and paste the information from your SAP Concur solution into the case especially for complicated items such as record locator, report IDs, or job numbers to ensure accuracy.

SAP Concur Support offers a Co-browse feature which is a secured screen-share application providing view-only access to your SAP Concur solution. This feature is available to Authorized Support Contacts located under the Help menu.

### 6.4 How do I begin a Chat session?

Chatting with SAP Concur Support is easy! To start a chat session, click **Chat with Support** on the home page. A pre-chat window will appear, prompting you to select Expense, Travel, Invoice, or Concur Request based on the assistance needed. Once accepted by the representative, the chat window will display. After a chat session ends, a transcript will be attached to the case.
6.5 Where can I find the global SAP Concur Support phone numbers?
The Global Support phone numbers can be found on the Home page > Call Support > View global phone numbers. When calling Support, if all representatives are engaged with other customers, a callback feature will be offered to reserve your place in the queue by entering a phone number.

7 KNOWLEDGE BASE

7.1 How do I search for Knowledge Base articles?
The Knowledge Base (KB) is accessible in 5 different areas:

1. The Home Page
2. The Support Tab
3. The Resources Tab
4. The Quick Link Menu Bar (at the bottom of the page)
5. Upon Creating a Case

Regardless of how you access the Knowledge Base, relevant articles appear in the middle section when you:

1. Type in a word or phrase in the Ask us anything search box.
2. Select any Filters to customize results.
   - Search results are automatically filtered for the language selected in My Profile.
   - View search results in additional supported languages by selecting the applicable language filter.
   - Articles are not translated in all supported languages.
3. Review results in the middle panel.
4. To open an article, click the applicable article link and a new window will open, displaying the article on the screen. From here, you can return to the Knowledge Base or log a case.
7.2 In what supported languages may Knowledge Base articles be offered?  
Knowledge Base articles may be offered in the following supported languages: Chinese (Simplified), English, French, German, Japanese, Korean, Portuguese (Brazilian), and Spanish.

7.3 How do I view a Knowledge Base article in another supported language?  
1. Search for and click the applicable article link.  
2. Click the Language drop-down to view the available languages.  
   - Only languages that articles are translated in will appear in the drop-down menu.  
3. Select the desired language.

8 CASE MANAGEMENT

8.1 How do I create a case?  
You can create a case directly from the home page or the Support tab. To create your case:  
1. Click Create a Case.  
2. Enter details in the Case Description field including steps to reproduce an issue, unique identifiers, date and time, impacted end-users, or other pertinent details related to the case.  
3. Enter a brief description of the case in the Subject field.  
   Based on the subject entered, any relevant Knowledge Base articles or Concur Training resources such as user guides, videos, release notes, and other documents will be displayed in the Suggested Articles section.
4. Within the **Suggested Articles** section, click the appropriate link to display the article or resource.

- To review a specific article, click the article link and a new window will open.
  
  o If the article answers your question, click *Yes – Take me to the Knowledge Base* or navigate to another tab on the portal.
  
  o If your question has not been answered, click *No – I want to log a Case*.

- If no relevant articles display, click *Continue Creating a Case*. 
5. Select the most appropriate Topic and Case Type from the drop-down lists.

6. Select the most appropriate Urgency (Customer Assessment) from the drop-down list. The options include:
   - 1 – Very High (Core service is completely down)
   - 2 – High (Business processes seriously disrupted)
   - 3 – Medium (Business processes affected)
   - 4 – Low (Little or no effect on business processes)

7. Cases automatically default to Priority 3 – Medium, assigned by SAP Concur once the case is reviewed. The priorities are described in the Customer Response Levels section of the Support Policy for SAP Cloud Services and determines the maximum length of time for initial response, ongoing communications, and targeted resolutions.
   **Note:** For resolutions that are dependent upon third-party vendors, the ongoing communication levels are not applicable.

8. Select the appropriate Case Region from the drop-down list. The options include:
   - APA
   - EMEA
   - LATAM
   - North America

9. Enter the Site/URL/Acct. #, if applicable.

10. If the preference is to have an SAP Concur Support representative call before working the case, select the Call Me box. Please ensure the correct phone number is listed in My Profile.

11. To authorize SAP Concur to troubleshoot the case within your production site, select the Concur may test in my production site box.

12. If Service Administration or Service Assistant has been purchased, check the Service Admin box to route the case to the applicable queue.
13. Enter up to eight additional e-mail addresses in the CC E-mail field to include others on updates from SAP Concur Support.

**Note:** Case owners can update cases through e-mail, however, updates cannot be viewed from the SAP Concur Support Portal.

14. Click *Submit & Add Attachments* to attach any documentation that can assist SAP Concur Support in the case resolution. Complete the three steps to attach a file. Each file is limited to 25MB.

**Note:** For security purposes, attachments are not allowed on case updates through e-mail.

15. Click *Submit* and a case number will automatically be assigned.

**Note:** For data files, the preferred method is to upload the import or export job file to a company’s File Transfer Protocol (FTP) site without encryption. This method allows SAP Concur Support to access and view files in a secure manner. Additionally, please do not attach files with sensitive data such as complete credit card or social security numbers.

### 8.2 How does SAP Concur Support determine the order to work cases?

All cases will automatically default to a Priority 3 (P3) and once SAP Concur Support reviews the case, a priority is assigned. The priorities are described in the Customer Response Levels section of the [Support Policy for SAP Cloud Services](#) and determines the maximum length of time for initial response, ongoing communications, and targeted resolutions.

**Note:** For resolutions that are dependent upon third-party vendors, the ongoing communication levels are not applicable.

Based on assigned priority, cases will be worked as listed below:

- 24x7 Mission Critical Support for P1 and P2 issues (English only)
- Non-Mission Critical Support for P3 and P4 issues during business hours (English only) – Monday to Friday 8 am to 6 pm (Local Time Zone), excluding local holidays

### 8.3 How do I view a case?

You can view a case directly from the home page or you can click the *Support* tab. To view your case(s):

1. Click *View Cases*.
2. From the View drop-down list, choose from one of the following options:
   - 1 – All Open Admin Cases
   - 2 – All Closed Admin Cases
   - 3 - *All Open End User Cases
   - 4 - *All Closed End User Cases
   - 5 – My Cases
   - 6 – Recently Viewed Cases

*These selections are only available if the User Support Desk service has been purchased. If purchased, please do not edit end-user cases as they are in Support's hands.*
3. To sort cases by ascending or descending order, click on a specific column heading.
4. To view one case at a time, click the **Case Number** or **Subject** link.
5. To update a case, click **Add Comment** in the **Case Comments** section.
6. To search the Knowledge Base, click **Find Articles**.
7. To add an attachment, click **Attach File** and complete the three steps. Each file is limited to 25 MB.

**Note:** Case owners can update cases through e-mail, however, for security purposes, attachments are not allowed. Additionally, e-mail updates cannot be viewed from the portal.

### 8.4 How do I close a case?

1. To close a case, open the applicable case and click the **Close Case** button.

2. Select **Closed** under **Status** and click **Submit**.
8.5 How do I print cases?
To print a list of cases, click View Cases within the Support tab. On the right, click Printable View. An additional page will display where you can adjust print options prior to printing.

8.6 How do I download a case report?
1. To download a report, click the Support tab at the top of the menu bar.
2. Click Download Case Report.
3. Select the appropriate Report Criteria:
   - Report Type: My Organization’s Cases, My Cases, or End User Cases
   - Case Status
   - Cases Created Between and/or Cases Closed Between
   - The number of records per page
4. Click Execute Report. Executing a report runs the query to pull the requested data which is displayed on the screen.
5. Click Download Report.
   - If there are more than 250 records, click Report Files. When the report is available for download, the Request Status will change from Requested to Complete and the Download Report link appears.
   - Note: An e-mail notification will be sent when the report is available to download.
   - Downloading the report transfers the following data into an Excel file: Subject, Case #, Date Created, Reported By, Date of Last Comment, Status, Site/URL/Acct. #, and Date Closed.
Note: The end-user and Audit Cases report types are only available to download if the User Support Desk and/or Audit services have been purchased.

9 RESOURCES

9.1 How do I find general information such as technical documentation and training options?

Whether you’re accessing Resources from the Menu Tabs at the top of the page or using the Quick Link Menu Bar at the bottom of the page, you will find the following information on the Resources page:

- Knowledge Base
- Release/Tech Info
- Training
- Webinars

9.2 How do I find the Release Notes, Release Calendar, and Client Admin Release Summary?

- Professional Edition Customers
  - Resources > Release/Tech Info

- Standard Edition Customers
  - Resources > Release/Tech Info – Standard: Release Notes

9.3 What is a Fact Sheet?

Fact Sheets describe new features, the associated configuration steps, and the steps the customer should take to prepare for feature activation.

Fact Sheets are different from permanent documentation (such as Setup Guides, User Guide, etc.)

- Permanent documentation is provided when a feature is generally available (GA) to all clients.
  - Fact Sheets are temporary documents that cover the period of time when a feature is available internally or to Early Adopters but not GA.
  - Permanent documentation is revised regularly and kept up-to-date.

Once the feature is generally available, customers and internal audiences should use the Release Notes and the permanent documentation instead of the Fact Sheets.
9.4 How do I print Fact Sheets?
The Resources page defaults to the Knowledge Base. Click on the Release/Tech Info link. A Fact Sheet section is located on this page. This will direct you to another site where you can view and/or print PDFs and Word documents.

Note: Fact sheets are available for Professional Edition customers only.

9.5 How do I find training information?
Trainings and webinars are available in the Resources tab. The Training link directs you to the applicable Training Toolkit for a variety of webinars and guides.

- Professional
- Standard

The Webinars link displays available Travel-related and Getting the Most from SAP Concur Support e-Learning courses.

10 COMMUNITY INFO

10.1 Community
The Community is where ASCs can make connections with other ASCs, post questions and answers, and participate in Community discussions. The Communities are based on your product edition; Professional edition customers are part of one community while Standard edition customers are part of another.
10.1.1 How do I post a question?

1. Type your question in the *What would you like to know?* search field.
2. Press *Enter* on your keyboard or click the search icon. Similar questions or articles will appear.
3. If there are no similar posted questions or articles, click the *Post Your Question* button.

10.1.2 How do I search for items posted?

From the *Community* link, you can search for answers and questions using the Search bar. Just underneath, you can use the drop-down menu to search by *All Questions, Unanswered Questions*, etc. You can sort by *Most Popular* or *Recent*, etc. to streamline your answers. Answers will appear in the middle panel. You can also browse by categories from the left-hand side.
10.1.3 How do I comment on a post made by another user?

Select Answer to provide a comment or answer. If you see a post you like, let the community know by selecting Like. You can also Follow a post and even Flag it as Spam, Inappropriate, or Hateful if you no longer want it to appear on your Community page.

10.1.4 How do I view a list of questions I submitted on the portal?

To view questions you submitted, use the drop-down menu under the Search bar and select My Questions.
10.2 Solution Suggestions

10.2.1 Where do I change my Solution Suggestions Nickname?

To personalize your Solution Suggestions, you can change your nickname by navigating to My Profile > Solution Suggestions and Community Nickname.

![SAP Concur interface](image)

10.2.2 What do the different statuses for Solution Suggestions mean?

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>Available for community voting.</td>
</tr>
<tr>
<td>Under Review</td>
<td>Achieved top-voted suggestion status and is being assessed.</td>
</tr>
<tr>
<td>Future Consideration</td>
<td>Aligns to Product Direction, but not On Roadmap. Will be considered during roadmap planning to either be added On Roadmap, kept for Future Consideration, or Declined.</td>
</tr>
<tr>
<td>On Roadmap</td>
<td>Aligns with current Product Direction and is on the Roadmap.</td>
</tr>
<tr>
<td>Declined</td>
<td>Does not align with Product Direction or has not received widespread interest, and will not be incorporated into the roadmap or actioned further.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Merged with a similar Solution Suggestion.</td>
</tr>
<tr>
<td>Existing Feature</td>
<td>Suggested feature or functionality already exists; contact your Account Manager for more information.</td>
</tr>
<tr>
<td>Delivered</td>
<td>A solution to this suggestion has been delivered.</td>
</tr>
<tr>
<td>Archived</td>
<td>Solution Suggestion has not received widespread interest, has not been active in the past year, or has not met criteria for additional consideration. It will not be actioned further.</td>
</tr>
</tbody>
</table>

10.2.3 How do I view Solution Suggestions?

1. Navigate to Community Info and click Solution Suggestions.
2. To view Popular, Recent, Top All-Time Solution Suggestions, or Comments, click on the appropriate tabs.
3. To filter the results, select the desired Category and/or Status from the applicable drop-down menu.

Note: Popular Solution Suggestions is the default.
10.2.4 How do I search for an existing Solution Suggestion?

1. If the Solution Suggestion ID (SS Number) is unknown, type in a word or phrase in the Ask me anything search box on the home page.
2. Select any Filters to customize results.
3. Review results in the middle panel.

Note: Best practice is to search for existing Solution Suggestions before submitting a new suggestion to avoid duplicates.

10.2.5 How do I promote a Solution Suggestion?

To promote a Solution Suggestion, click the Promote box.

If you would like to add a comment, click the Comment link.
10.2.6 How do I submit a Solution Suggestion?

1. Navigate to Community Info and click on Solution Suggestions.
2. Click the Post Solution Suggestions link under the lightbulb icon or the gold box.
3. Add a title. As you enter a title, the system will search and display Similar Ideas. Review to avoid submitting duplicate suggestions.
4. Enter in your description.
5. Select a category from the drop-down menu.
6. Click Post.
   **Note:** New suggestions default to Open status.

10.2.7 How do I view my suggestions or votes?

Click your Solution Suggestions Nickname to display a page where you can view the suggestions you have submitted and voted on.
11  BILLING

11.1 How do I access invoices online?
1. Click the Billing tab.
2. Click the link to access invoices after January 1, 2017.

Note: For invoices before January 1, 2017, submit a Billing Question case or contact your AR Customer Representative. For additional information or if your organization has more than one Billing Account, refer to the Online Billing Portal Guide located on the Concur Training Library.

12  CUSTOMER SUPPORT DOCUMENTATION AND E-LEARNING

The resources listed below can be found in the Concur Training Library.

- Getting the Most from SAP Concur Support
- Getting the Most from SAP Concur Support Quick Reference Guide
- Getting the Most from SAP Concur Support e-Learning Course
  - The corresponding e-Learning course can also be accessed by following this path on the SAP Concur Support Portal: Resources > Webinars > Concur Support Training.
- Getting the Most from User Support Desk Quick Reference Guide
- Online Billing Portal Guide